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ABSTRACT 

This set of instructions for producing a paper for CSCI 240 and CSCI 245 at Bucknell University. This 
template and instructions come directly from the 2017 Winter Simulation Conference (WSC 2017) author 
kit with minimal modifications. All the credits for the construction of this template and instructions 
belong to the Proceedings Co-Editors of WSC 2017. You should use this Microsoft Word template to 
produce your submission – it serves also as a checklist to ensure that you are meeting the expectations of 
the assignment. Follow the guidelines herein when preparing your paper – good formatting determines 
part of the grade you will earn. 

1   INTRODUCTION 

These are instructions for the preparation of papers for CSCI 240 and CSCI 245 with Microsoft Word. 
When preparing your paper in Word, you are required to use the Word template, wsc17word.dotx. The 
easiest way to use this template is to simply copy the template to your working directory and double-click 
the template from your operating system. This will launch Word and will create a new document based on 
the template. Alternatively, copy the template into the directory containing Word’s default templates. The 
default template directory depends on the operating system. Find the default template directory by 
searching for one of the default templates (for example, normal.dot). Then place the new template in that 
directory. To access the template, you should open a new Word document by clicking on Office button, 
selecting New from the menu; and selecting “Installed Templates” from the options listed under templates 
on the left in the “New Documents” window that appears (Shift key + underlined letter can be used to 
select the option; in this case pressing shift and N keys together will open the “New Documents” 
window).  

A set of styles are defined in the template so that authors can easily achieve the required format. You 
should look carefully at how the styles are applied in this document. One simple way to get started with 
styles is to start with the sample paper and simply replace the existing text. Do not try to make “manual” 
formatting changes to the text—let styles do the work. For example, instead of manually indenting 
paragraphs to conform to the specifications, simply apply the corresponding predefined style from Table 
1; the paper will then meet indenting requirements. To view the styles defined in wsc17word.dotx, open 
the Styles Panel by clicking the bottom right corner arrow button in the “Styles” group on the “Home” 
ribbon in MS Word 2010 (please use MS Word help to identify corresponding capabilities in other 
versions). The Styles panel also shows the style currently applied to the text at the current cursor position 
as the boxed style in the list. To apply different formatting, choose the appropriate style from the list. The 
specific formatting instructions for a style may be viewed by placing the cursor over the style of interest. 
For additional help with styles, review the Word Help topic “Style basics in Word.” Avoid updating the 
styles that are provided; the proceedings editors have checked that the formatting provided by the styles is 
that needed for the WSC.  
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Table 1: Defined Word styles. 

Style Name Description 
Abstract Heading Heading style for Abstract 
Appendices Appendix heading 
Biography Author Biographies 
Equation Equations 
Figure Label Single-line figure caption 
Figure Label Multiline Multi-line figure caption 
Heading Unnumbered headings – e.g. References, 

Acknowledgments, Author Biographies, 
etc. 

Heading i Numbered headings for level i headings 
Hyperlink Hyperlinks 
List Bulleted Bulleted lists 
List enum Numbered lists 
Normal Normal text – no indent – used for first 

paragraphs after headings 
Normal Indent Normal text – indented – used for all 

paragraphs following the first for a 
section. 

Program “in-between” lines in a program listing 
ProgramBoth Single-line program statements 
ProgramEnd Last line in a program listing 
ProgramStart First line in a program listing 
Table Label Single-line table caption 
Table Label Multiline Multi-line table captions 
Title Paper Title 

 
Note that some styles appearing in this paper’s styles set are not found in earlier WSC templates nor 

in Table 1 because formatting that is added during the normal editing process will appear in the Style 
Area Panel. The safest way to ensure conformance to formatting requirements is to apply only styles that 
are listed in Table 1 below and in the wsc17word.dotx template file. 

2   GENERAL GUIDELINES 

2.1   Objectivity 

The content of the paper should be objective and balanced without any attachment to any specific 
ideology. I. 

2.2   Paper Submission 

You will electronically submit the paper using Moodle. The submission instructions on Moodle will 
direct you to turn in three different deliverables on three separate hyperlinks:   
 

•   Title and abstract 
•   Paper as an MS Word file 
•   Paper as a PDF file 
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2.2.1  Length of the Abstract 

The abstract must be at most 150 words. The abstract should consist of a single paragraph, and it should 
not contain references or mathematical symbols. 

2.2.2  Length of the Paper 

The page size for your article must be 8.5 inches by 11 inches (21.6 cm by 27.9 cm). The overall length of 
the paper depends on the class you are taking.  

•   CSCI 240 Computers and Society AND CSCI 245 Life, Computers, and Everything 
short papers should be at most 2 pages long including bibliography. Short papers 
should have no figures and no abstract, but they must have at least three sections: 
introduction, discussion, and conclusion. 

•   CSCI 240 Computers and Society term papers should be at most 4 pages long (3,000 to 
3,500 words) including bibliography and any possible figures. 

•   CSCI 245 Life, Computers, and Everything term papers should be at most 8 pages long 
(4,000 to 5,000 words) including bibliography and any possible figures. 

This length requirement is not meant to restrain your enthusiasm for reporting your good research work. 
Instead, it is meant to mimic typical publications constraints that discourage authors from rambling. The 
length restriction should help you to stay focused on your contribution. 

2.2.3   Font Specification and Spacing 

The paper should be set in the Times New Roman font using a 11-point font size. The paper should be 
single spaced. Do not use other fonts, font sizes, or line spacing. 

2.2.4  Margins 

The width of the text area is 6.5 inches (16.0 cm). The left and right margins should be 1 inch (2.54 cm) 
on each page. Except for the first page, the top and bottom margins should be 1 inch (2.54 cm). First page 
has 1.5 inch margin from the title to the top of the page, and 1 inch bottom margin. In this MS Word 
template, the header and footer are set to, respectively, 0.69 inch and 0.75 inch for the first page and 0.89 
inch and 0.75 inch for all other pages. Authors should not change these header and footer settings when 
preparing a manuscript.  

2.2.5   Justification 

Headings of sections, subsections, and subsubsections should be left-justified. One-line captions for 
figures or tables should be centered. A multiline caption for a figure or table should be fully justified. All 
other text should be fully justified across the page (that is, the text should line up on the right-hand and 
left-hand sides of the page). 

2.3   Headings of Sections, Subsections, and Subsubsections 

Section, subsection, and subsubsection headings should appear flush left, set in the bold font style, and 
numbered as shown in this document. The headings for the Abstract, Acknowledgments, References and 
Author Biographies sections are not numbered. Section headings should be set in FULL CAPITALS 
LIKE THIS PHRASE, while subsection and subsubsection headings should be Capitalized in Headline 
Style like This Phrase. Lengthy headings should be broken across two or more lines. Again, these 
formats should be accomplished using the styles Heading 1, Heading 2, Heading 3, etc. 
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2.3.1   Paragraphs 

The first paragraph after a heading should not be indented; all other paragraphs should be indented by 
0.25 inches. Do not insert additional space between paragraphs. 

2.3.2   Footnotes 

Do not use footnotes; instead incorporate such material into the text directly or parenthetically. 

2.3.3    Page Numbers 

Do not include page numbers. Page numbers are generated by the proceedings editors once all accepted 
papers are ordered for the final proceedings. 

3   FORMATTING THE FIRST PAGE 

3.1   Running Heads 

The running head (provided in the template) in the upper left-hand corner of the first page (which should 
read Proceedings of the 2018 Rooke Chair Symposium) is left-justified and set in the 11-point italic font 
style. You do not have to change the content of the first page header; the first page header was in the 
preparation of this document. 

Running heads on the second and subsequent pages should contain the last name of the author, 
centered and set in the 11-point italic font style. For example, if the author’s name is “L. Felipe Perrone,” 
the running heads for the should read Perrone. Go to the second page of your document, click on the 
running Header and change it to your last name. 

3.2   Title and Authors 

Center the title of the paper on the page and set it in bold FULL CAPITALS so that the top edge of the 
title begins 1.5 inches from the top of the page. Multiline titles should have about the same amount of text 
on each line. There should be 2 blank lines between the title and the author’s name.  

The author’s name should be capitalized and centered on a new line, with the author’s first name first 
and no job title or honorific. Insert 1 blank line between the author’s name and address. The organization 
or institution that the author is affiliated to should be typed first. Next type the complete street address, 
without abbreviations, followed by the city, standard two-letter state or province abbreviation, postal 
code, and country. The address should be centered and capitalized, except for the country, which should 
be set in FULL CAPITALS.  

4   FORMATTING SUBSEQUENT PAGES 

Please refer to section 2.2.4 for the correct margins! 

4.1   Mathematical Expressions in Text and in Displays 

Display only the most important equations, and number only the displayed equations that are explicitly 
referenced in the text. To conserve space, simple mathematical expressions such as å =

-= n
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1  may be 
incorporated into the text. Mathematical expressions that are more complicated or that must be referenced 
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If a display is referenced in the text, then enclose the equation number in parentheses and place it 
flush with the right-hand margin of the column. For example, the quadratic equation has the general form 

 
.0where,02 ¹=++ acbxax       (1) 

 
In the text, each reference to an equation number should also be enclosed in parentheses. For 

example, the solution to (1) is given in (2) in Appendix A. Note that equation numbers are not 
automatically generated or referenced. 

If the equation is at the end of a sentence, then you should end the equation with a period. If the 
sentence in question continues beyond the equation, then you should end the equation with the 
appropriate punctuation—that is, a comma, semicolon, or no punctuation mark. 

The equations can be entered using the Equation option available in the Symbols group on the Insert 
tab in Microsoft Word 2007 or 2010, or using Microsoft Equation Editor in older versions of Microsoft 
Word. For Microsoft Word 2007 or 2010, the equation capability makes entering equations quite 
convenient but numbering them requires using tables. Instructions for inserting equation numbers for 
Microsoft Word 2007 and 2010 are available online at WordTips (Sharon Parq Associates 2011).  

If you are using Microsoft Equation Editor 3.0, then select the “Equation” style on the line where the 
equation will appear. Then press the TAB key to move the cursor to the center of the column. From 
Word’s Insert ribbon, select Object in the Text group. In the pull down menu that appears, select Object, 
and in the Object panel, select type Microsoft Equation 3.0, and type the equation. While in the Equation 
Editor, you should verify that the font size is at most 11 points. On the Equation Editor’s menu bar, select 
Size > Define, and set the “Full” font size to 11. Close the Equation Editor. If you want to include the 
equation number, press the TAB key. This will move the cursor to the right-hand margin; then type the 
equation number enclosed in parentheses. Insert a blank line after the equation and then return to the 
“Normal” style to continue a paragraph or “Normal Indent” to start a new paragraph. 

If you are using MathType, insert a blank line before the line for the equation. Click the “Insert 
Display Equation” button on MathType’s Equation Editor menu bar. Before you type the equation, verify 
that the font size is at most 11 points by choosing Size > Define. After typing the equation, close the 
MathType Equation Editor, press the TAB key to move the cursor to the right margin, and type the 
equation number, if any, enclosed in parentheses. For unnumbered equations, MathType users should 
click the “Insert Display Equation” button. 

4.2   Displayed Lists 

A displayed list is a list that is set off from the text, as opposed to a run-in list that is incorporated into the 
text. The bulleted list given below provides more information about the format of a displayed list.  

 
•   Use standard bullets instead of checks, arrows, etc. for bulleted lists. 
•   For numbered lists, the labels should not be Arabic numbers enclosed in parentheses because 

such labels cannot be distinguished from equation numbers. 
•   You may need to restart the numbering on numbered lists. To do so, right click on the first entry 

in the list. 
 
Indent the paragraph after the list. Include an empty line before and after the list. 

4.3   Definitions and Theorems 

Definitions, theorems, propositions, etc. should be formatted like a normal paragraph with a boldface 
heading as shown in the examples below. Number these items separately and sequentially. You may 
choose to separately number theorems, propositions, corollaries, etc., as opposed to the example below 
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where corollaries and theorems are numbered together. Do not use a period after the definition, theorem, 
corollary or proposition number, but do end the sentence with a period. 

 
Definition 1 In colloquial New Zealand English, the term dopey mongrel is used to refer to someone 

who has exhibited less than stellar intelligence. 
Theorem 1 If a proceedings editor from New Zealand accidentally deletes his draft of the author kit 

shortly after completing it, he would be considered to be a dopey mongrel. 
Corollary 2 One of the proceedings editors is a dopey mongrel. 
 
Indent the paragraph after the definition or theorem. Include an empty line before and after the item. 

4.4   Figures and Tables 

Figures and tables should be centered within the text and should not extend beyond the right and left 
margins of the paper. Figures and tables can make use of color. However, try to select colors that can be 
differentiated when printing in black and white in consideration of vast majority of people using such 
printers. Figures and tables are numbered sequentially, but separately, using Arabic numerals. All tables 
and figures should be explicitly referenced in the text and they should not be placed before they are 
referenced. 

To insert a table, use the usual Table option on the Insert ribbon. To center the table, first select the 
table, then right click and select Table Properties, followed by the Table tab and click the Center button 
for Alignment and the None button for Text wrapping. For figures which can fit next to each other, the 
author can choose to align them next to each other with the figure text centered below each figure and on 
the same line for both figures. For tables which can fit next to each other, the author can choose to align 
them next to each other with the table text centered above each table and on the same line for both tables. 

Each table should appear in the document after the paragraph in which the table is first referenced. 
However, if the table is getting split across pages, it is okay to include it after a few paragraphs from its 
first reference. The table’s single-line captions are centered, while multiline captions are left justified. 
This template does not use the Word capabilities to insert table captions and thus does not use the 
automatic referencing capabilities of Word. Instead add the appropriate caption above the table and use 
the “Table Label” style for tables with a single-line caption. Use the “Table Label Multiline” style for 
multiline table captions. The styles include inserting a 12 pt. space above and a 6 pt. space after the 
caption. The caption should begin with the word Table, followed by the table number and a colon. 
Captions can be written using normal sentences with full punctuation. All captions should end with a 
period. It is fine to have multiple-sentence captions that help to explain the table. Include one line space 
below the table. See Tables 1 and 2 for examples. 

Table 1: Table captions appear above the table, and if they are longer than one line they are left justified. 
Captions are written using normal sentences with full punctuation. It is fine to have multiple-sentence 
captions that help to explain the table. 

Creature IQ Diet 
dog 70 Anything 
cat 75 almost nothing 

human 60 ice cream 
dolphin 120 fish fillet 
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Table 2: Counting in Maori. 

English Maori 
one Tahi 
two Rua 

three Toru 
 
Each figure should appear in the document after the paragraph in which the figure is first referenced. 

However, if the figure is getting split across pages, it is okay to include it after a few paragraphs from its 
first reference. Figure captions appear below the figure. Single-line captions are centered, while multiline 
captions are left justified. This template does not use the Word capabilities to insert figure captions and 
thus does not use the automatic referencing capabilities of Word. Instead add the appropriate caption 
below the figure and use the “Figure Label” style to label the figure for a single-line caption. Use the 
“Figure Label Multiline” style for multiline captions. The styles include inserting a 6 pt. space above and 
a 12 pt. space after the caption. Include one line space above the figure. The caption should begin with the 
word Figure, followed by the figure number and a colon. Captions end with a period. See Figures 1 and 2 
for examples. 

Paste figures as pictures into the document. To center the figure , select the picture, right-click, and 
choose Format Picture. From the Layout tab, first check “Center” in Horizontal Alignment section, next 
select “Advanced” and then select “Top and Bottom” on the “Text Wrapping” tab and click OK. With the 
picture selected, apply the “Centered” style. 

 
 

Figure 1: An unusual answer to a question. 
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Figure 2: The area of the square is 64 squares, while that of the rectangle is 65 squares, yet they are made 
of the same pieces! How is this possible? 

References to tables and figures identified by number are capitalized. For example, “We see in Table 
5 that…” and “We see in the previous table that…” are both correct. 

Please ensure that the text within figures uses standard fonts and is readable (Times New Roman, 
Symbol, etc.). 

4.5   Hyperlinks 

A hyperlink specifies a Web address (URL) or an e-mail address. The use of hyperlinks allows authors to 
give readers access to external electronic information, such as a dynamic simulation or animation. While 
the use of hyperlinked text is encouraged in the main body of the paper, it is recommended that 
corresponding web addresses and other identifying information should be provided in list of 
references. For example, instead of spelling out the web address of the conference website, one would 
refer to conference website and the corresponding entry in the reference section will spell out the 
associated web address and other relevant information such as author(s) and/or organization that 
published the content. This would allow readers to search for the content using the author(s), 
organization, etc. in case the actual web-address is changed. This also allows for a cleaner appearance of 
the main body of the paper. 

If the author feels that enough information is provided in the main body of the paper that can be used 
for searching for the cited content if the web address is changed and that the inclusion of the web address 
doesn’t hurt the appearance of the paper, the web address can be included in the main body of the paper 
itself. 

Each hyperlink should be set in the same font as the text. A live hyperlink (or hot link)—that is, a 
hyperlink that will activate your Web browser and take it to an external Web site or that will activate your 
e-mail software for sending a message to a specific e-mail address—should be colored blue. You can see 
examples of such hyperlinks in this paper. The use of live hyperlinks is at the discretion of the author(s). 

Using live hyperlinks requires the format defined in the “Hyperlink” style. To insert a live hyperlink 
into a WSC paper, please follow the following steps: 

 
1.   In the current paragraph style, enter the text where the live hyperlink is to appear. 
2.   Select the displayed text of the live hyperlink and apply the “Hyperlink” style. 
3.   With the displayed text selected, choose Insert > Hyperlink from the ribbon or right-click and 

select “Hyperlink.” 
4.   In the dialog box that appears, select the button labeled “Existing File or Web Page” or “E-mail 

address.”  
5.   In the second box labeled “Address” type only the correct e-mail or Web address, with the prefix 

http:// for a Web address. 
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6.   For hyperlinks with web addresses, enter an appropriate citation following the text and provide 
the web address and other relevant information in the corresponding entry in the list of references. 

 
If it is necessary to break the displayed text of the e-mail or Web address across two or more lines, 

then a soft return (SHIFT+ENTER) may be used to insert line breaks in the displayed text of the live 
hyperlink (as opposed to being inserted in the “Address” box referred to above). These soft returns should 
be added to the displayed text prior to step 3.  

If any editing is made to the displayed text of a live hyperlink, then the “Address” box referred to 
above should be rechecked to ensure no extraneous characters have been introduced into that box. To 
check the “Address” box for accuracy, place the cursor anywhere in the displayed text of the hyperlink 
and right-click. Select “Edit Hyperlink.” If extraneous characters have been introduced, delete them from 
the “Address” box. 

Non-live hyperlinks—that is, the hyperlinks that are included for the reader’s information but do not 
actually invoke the reader’s Web browser or e-mail software should be colored black.  
 If the authors use hyperlinked text in the main body of the paper, they must ensure that each hyperlink 
includes a citation (e.g. (WSC BoD 2017) following the hyperlinked text “conference website” in Section 
1), a corresponding entry is provided in the list of references, and the associated web address displayed 
for the hyperlink is complete and correct so that a reader who has only a hard copy of the paper can still 
access the cited material by typing the relevant part of the displayed text of the hyperlink into the address 
bar of a Web browser. If the authors opt for including the web address in the main body of the text itself, 
they must ensure that the hyperlink is complete and correct for the same reason. 

4.6   Citing a Reference 

To cite a reference in the text, use the author-date method. Thus, Chien (1989) could also be cited 
parenthetically (Chien 1989). For a work by four or more authors, use an abbreviated form. For 
example, a work by Banks, Carson, Nelson and Nicol would be cited in one of the following ways: Banks 
et al. (2000) or (Banks et al. 2000).  

Parenthetical citations are enclosed in parentheses ( ), not square brackets [ ]. The items in a series of 
such citations are usually separated by commas. If an item in the series of parenthetical citations contains 
punctuation because (for example) it refers to a work with three or more coauthors, then all items must be 
separated by semicolons. 

The following is a list of correct forms of citations: 
 
•   Brown and Edwards (1993), 
•   (Brown and Edwards 1993), 
•   (Smith 1987, Brown and Edwards 1993), and 
•   (Smith 1987; Arnold, Brown, and Edwards 1992; Brown et al. 1995). 

 
The following is a list of incorrect forms of citations: 
 
•   Brown and Edwards [1993], 
•   (Brown and Edwards, 1993), 
•   (Smith, 1987; Brown and Edwards, 1993), and 
•   (Smith 1987, Arnold Brown and Edwards 1992, Brown et al. 1995) 
 
For further details, please refer to Chicago Manual of Style (The University of Chicago Press 2010). 

The proceedings editors have also provided an EndNote style file to assist with proper formatting. (The 
use of EndNote is not required.) 
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4.7   List of References 

Place the list of references after the appendices. The section heading is REFERENCES, and is not 
numbered. List only references that are cited in the text. Arrange the references in alphabetical order 
(chronologically for a particular author or group of authors); do not number the references. Give complete 
references without abbreviations. To identify multiple references by the same authors and year, append a 
lower case letter to the year of publication, for example, 1984a and 1984b. 

Use hanging indentation to distinguish individual entries. Do not insert additional space between 
references. The bibliographic style for a journal article is: 
<Surname of first author>, <Author’s initial(s)>, <Initials and surnames of other authors>. <year>. 

<Capitalized article title in quotes>. <Journal Name in Headline Italics> <Volume number>:<page 
numbers>. 
The format for other types of reference can be inferred from the examples in the references section, 

which include: 
 
•   a technical report (Chien 1989), 
•   a proceedings article (Cheng 1994), 
•   a journal article (Gupta, Nagel, and Panchapakesan 1973), 
•   a book by 2 authors (Hammersley and Handscomb 1964), 
•   a chapter in a book (Schruben 1979), 
•   an unpublished thesis or dissertation (Steiger 1999), 
•   a book with no identified authors (The University of Chicago Press 2010), and 
•   a document available on the web (WSC Foundation 2011). 

 
Again, for further details and examples, please refer to Chicago Manual of Style (The University of 

Chicago Press 2010). Please note that the examples given in the reference section of this document are 
based on the 16th edition of the Chicago Manual of Style. Authors can use the style based on the 15th 
edition of the manual that they have been using in the papers for the past Winter Simulation Conferences 
at their discretion. However, the two styles should not be mixed. Clarity and consistency should be your 
primary concern. The proceedings editors have provided an EndNote style file to assist with proper 
formatting. (The use of EndNote is not required.) 

5   AUTHOR CHECKLIST 

We strive for a consistent appearance in all papers published in the proceedings. If you used the template 
and styles within this author’s kit, then almost all of the requirements in this checklist will be 
automatically satisfied, and there is very little to check. 

Please print a hardcopy of your paper, and go over your printed paper to make sure it adheres to 
the following requirements. Thank you! 

 
1.   Abstract 

(a)   150 or fewer words. 
(b)  No list of keywords.  

2.   Paper Length 
(a)   At least 5, but no more than 5 or 9 pages (5 for CSCI 240 and 9 for CSCI 245). 
(b)   Page size is letter size (8.5’’ x 11’’, or 216 mm x 279 mm). 

3.   All text is in 11-Point Times New Roman. 
4.   The paper has been spellchecked using U.S. English.  
5.   Spacing and Margins 

(a)   Single spaced. 



Perrone 
 

(b)   Left and right margins are each 1 inch. 
(c)   Top and bottom margins are each 1 inch except first page. 
(d)   First page has 1.5 inch margin from the title to the top of the page, and 1 inch bottom margin. 

6.   Section Headings 
(a)   Left justified and set in BOLDFACE ALL CAPS. 
(b)  Numbered, except for the abstract, acknowledgments, references and author biographies. 
(c)   Subsection headings are set in Headline Style. 

7.   No footnotes or page numbers. 
8.   The running head on the first page is as given in the template file, and the running head on 

subsequent pages is the surnames of all authors. 
9.   The title is in 11 POINT BOLDFACE ALL CAPS 
10.  Multiple authors are formatted correctly, with email addresses and other information in the 

Author Biography section. 
11.  Equations are centered and any equation numbers are in parentheses and right-justified. 
12.  Figures and Tables 

(a)   All text in figures and tables is readable. 
(b)   Table captions appear above the table. Figure captions appear below the figure. 

13.  Citations and References 
(a)   Citations are by author and year, and are enclosed in parentheses, not brackets.  
(b)   References are in the hangref style, and are listed alphabetically by the last names(s) of the 

author(s).  
14.  Author biographies are one paragraph long. 
15.  Hyperlinks  

(a)   Live hyperlinks are blue. Nonlive hyperlinks are black.  
 
After verifying that your paper meets these requirements, please go to the final submission link on 

Moodle and submit your paper. Be aware that your work will be run through Turnitin, a service for 
plagiarism detection, so always cite your sources! 

ACKNOWLEDGMENTS 

Place the acknowledgments section, if needed, after the main text, but before any appendices and the 
references. The section heading is not numbered. These instructions are adapted from instructions that 
have been iteratively updated and improved by proceedings editors and several other individuals, who are 
too numerous to name separately, since the first set of instructions were written by Barry Nelson for the 
1991 WSC. 

A   APPENDICES 

Place any appendices after the acknowledgments and label them A, B, C, and so forth.  
  
 The solution to (1) has the form 

  0
2

42
¹

-±-
= a

a
acbbx .            (2) 

B   GETTING HELP 

If you need help in preparing your paper, contact Prof. Perrone well in advance of your submission 
deadline. Last minute inquiries, specially by late or middle of the night email, will be unlikely to 
receive responses in actionable time. 
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C   MOST OBSERVED MISTAKES 

The following list comprises the most common sources of error that had to be corrected by previous 
editors. Please make sure to go through the following list and check that your paper is formatted correctly: 

 
1.   The paper can be at most 12 pages long (15 for tutorials and panel sessions). Longer papers 

cannot be published. 
2.   Paper title and section titles are in ALL CAPS, subsections capitalize the first letter of 

important words. Please use the templates to use correct indents and spaces. 
3.   Paper is letter format, not DIN A4 format. Please use the required margins (different on page 

1 from the following pages). 
4.   Use the correct running heads! Use the proceedings editors and chairs on page one, and use 

the last names separated by commas for the other pages. Don’t forget that the last Last Name 
is preceded by “, and ”. Make sure the margins are correct on the running heads. 

5.   Double check the citation format! 
6.   Don’t forget the “author biographies” section! 
7.   Double-check that figures and tables are referenced in the text and have the correct caption 

format! 
8.   Double check that the author section after the title is formatted correctly: the number of 
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